ORACLE’

Release Notes:
AutoVue Web Version 19.3

Packaging

Renamed AutoVue Desktop Edition to AutoVue Desktop Version.

*  Renamed AutoVue Web Edition to AutoVue Web Version.

»  Added support for offline collaboration via the AutoVue Mobile product. See “AutoVue
Mobile” on page 3 for more.

System Requirements

Server

¢ Microsoft Windows 2008 32-bit, Windows 2003R2 32-bit, Windows 2003R2 64-bit
(AutoVue running in 32-bit mode), or Vista 32-bit.

* The installation requires about 400MB of free space.

» The memory requirements depend on the size and the complexity of the files being viewed.

Client

Clients running the following Java Virtual Machines:
* Sun Java VM 1.4.2 update 13, Sun Java VM 1.5.0 update 11 and Sun Java VM 6.0.
The following OSes and browsers:

* Microsoft Internet Explorer 6.0Sp2, Microsoft Internet Explorer 7, FireFox 2.0 on Windows
(ON)

 Safari 2.0.4, Firefox 2.0 on Apple MAC OS X 10.4

 Firefox 2.0 on RedHat Enterprise Linux 5

 Firefox 2.0 on Linux SUSE10 Sp2

* Mozilla 1.7 on Solaris 10 Sparc

Application Servers

The VueServlet has been certified on the following application servers:

¢ Tomcat 5.5

* WebSphere 5.1

* WebLogic 9.0

* Oracle Application Server 10g R3
+ JRUN 4

o Jetty 6.0

Installation
AutoVue Web Version

If you have an older version of AutoVue installed on your computer, we recommend that you
uninstall it before proceeding with the new installation.
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Before uninstalling your previous version of AutoVue server, make sure to save a backup copy of
any specific settings and content that you would like to push forward into your new version. This
can include the following:

*  AutoVue server settings from the "jvueserver.properties" file and "VueServer.ini" file (located
in the \bin directory of your AutoVue server installation)

*  AutoVue user profiles and custom GUI files (located in the \bin\Profiles directory of your
AutoVue server installation)

*  Global user settings from the "allusers.ini" file and default user settings from the “default.ini”
file (located in the \bin directory of your AutoVue server installation)

»  Custom logging settings from the “log4j.properties” file (located in the \bin directory of your
AutoVue server installation)

»  Markup files, if markups are being managed by AutoVue server (located in the \bin\Markups
directory of your AutoVue server installation)

*  Custom markup symbol libraries (located in the \bin\Symbols directory of your AutoVue
server installation)

If you decide to move these settings/content forward to your new installation of AutoVue, they can
for the most part be copied to the same relative locations in your new installation. However, for the
AutoVue server settings in "jvueserver.properties"”, as well as the global user settings in
"allusers.ini" and default user settings in “default.ini”, it is best to manually copy the specific
settings that you would like to keep, as the newer version of AutoVue may have important new
settings.

If you obtained AutoVue from the download site, extract the contents of the zip file and run
jInstall.exe. If you obtained the CD for AutoVue, run jInstall.exe that is located on the CD.

Follow on-screen instructions to complete the installation.

AutoVue Web Version Non-Interactive Installation

Silent installation has been replaced with non-interactive installation. Non-interactive installation
works similar to silent installation except that the installation progress screen is displayed during
the installation. It does not need any interaction from the user during installation. Refer to the
Installation and Administration Manual for instructions for running the installer in non-interactive
mode.

AutoVue Mobile

« Ifyou obtained AutoVue Mobile from the download site, extract the contents of the zip file and
run setuppg.exe.
If you obtained the CD for AutoVue, run setuppg.exe that is located on the CD.

The installer looks for an installation of AutoVue Web Version on the machine and installs to the
same location. Follow on-screen instructions to complete the installation.

Integrations with AutoVue 19.3

Release 19.3 has security enhancements. All integrations with AutoVue will need to be updated to
leverage these security enhancements. If you develop an integration with AutoVue, refer to the
JavaDMAPI.pdf that ships with AutoVue 19.3 (<AutoVue Installation Directory>\docs). The
JavaDMAPI.pdf has also been updated to include API needed for AutoVue Mobile and for
Intellistamps. The JavaDMAPI.pdf that ships with AutoVue 19.3 is more current than the document
that ships with the Integration SDK 19.2c1.

Requests made by AutoVue Server to the VueLink(s) will no longer contain the user.name cookie.
An alternative is to rely on the DMS/PLM/ERP/UCM user name instead of the user.name cookie.
This will need updates to your integrations.

To allow for backward compatibility, AutoVue has provided an option to allow user-credentials in
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all requests. This option is dms.vuelink.version in jvueserver.properties and the value is set to /9.2
by default. This will allow you to continue using your existing integrations with 19.3. In
subsequent releases of AutoVue, this backward compatibility option will be turned off. It is
important that you update your integrations to remove use of the user.name cookie.

The following pre-19.3 Oracle AutoVue VueLinks have been certified with AutoVue Web Version
19.3:

* VueLink for Documentum version 19.2
¢ VueLink for Oracle UCM 19.2

* AutoVue Integration SDK 19.2¢c1

e VueLink for SAP PLM version 19.2

The following pre-19.3 Oracle AutoVue VueLinks have also been certified with AutoVue Web
Version. However, these VueLinks need hotfixes in order to work correctly. Contact your Customer
Support representative if you use below VueLinks and you plan to upgrade to AutoVue version
19.3:

¢ VueLink for SharePoint 19.2

In addition to the list above, the integration with Agile PLM 9.2.2.3 has been certified with
AutoVue Web Version 19.3.

Note: When you upgrade to AutoVue version 19.3, you must update your VueLink installation
with AutoVue 19.3 client files (jvue.jar, jogl.jar and gluegen.jar) and VueServlet.jar. These files are
located in the bin sub-directory of the AutoVue 19.3 Installation directory.

If the VueLink is deployed as a webapp, you will need to update the webapp with the 19.3 jars and
then redeploy the webapp.

Functionality Enhancements

* Developed a new streamlined user interface for AutoVue:
» Redesigned icons
* Rearranged menu items based on usability studies.

*  Enhanced 3D look and feel. See“MCAD Functionality” on page 4 for more on 3D look
and feel and other 3D enhancements.

*  Enhanced Markup functionality. Added filtering of markup tree, added text box entity. See
“Markup Functionality” on page 4.

*  Renamed Cimmetry Metafile to AutoVue Streaming File.

AutoVue Mobile

Developed AutoVue Mobile product to enable viewing and marking up of design documents in a
disconnected mode. AutoVue Mobile also enables you to share design documents and markups
with your partners or suppliers that do not have access to your backend systems.

Using AutoVue Web Version, you can create a Mobile Pack for a file from your backend DMS/
ERP/PLM/UCM system. Once the Mobile Pack is created, you can provide it to your suppliers/
partners or you can access the file from a disconnected environment. You can use AutoVue
Desktop Version in order to view and markup the file in the Mobile Pack when there is no access to
the Web Version. If you added markups to the Mobile Pack, you can update your backend system
with the markups from the Mobile Pack using AutoVue Web Version.

When creating a Mobile Pack, you can include the base file, all the external resources (fonts, xrefs)
needed to fully display the file and associated markups in the Mobile Pack. You can choose to
include the streaming file instead of the base file. You can also include PDF or TIFF renditions in
addition to the base/streaming file when creating the Mobile Pack. You can also create policies to
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govern whether or not users that access the Mobile Pack can create new markups, modify existing
markups or delete markups.

Once a Mobile pack is created, you can view the drawing and markups by viewing the Mobile
Pack. You can create new markups or consolidate existing markups into one markup or create a
master markup that loads automatically when you view the Mobile Pack.

When you have access to your DMS/ERP/PLM/UCM system, you can update all the markups from
the Mobile Pack into the backend system. These markups will be imported into the system and will
be associated with the base file from which you originally created the Mobile Pack.

Refer to the AutoVue user guide for more information regarding creating, opening and working
with Mobile Packs.

Note: Creating a Mobile Pack from a DMS/ERP/PLM/UCM system and updating your backend
system from a Mobile Pack are only supported with the Web Version and require the AutoVue
Mobile product installed with the Web Version.

Note: A Mobile Pack created in the Web Version can be opened and marked up in the Desktop
Version.

MCAD Functionality

*  Enhanced the look and feel of the 3D workspace:

* Added a second light profile with 2 positional light sources.

* Added support for gradient background for 3D workspace. (Gradient background can be set
from the Configure dialog box)

* Added support for adding image background for 3D workspace. (Image background can be
set from the Configure dialog box)

* Improved 3D Axes look.

* Added reflective and reflective wire rendering modes to give 3D models a metallic look.

*  Added support for missing XRefs notification in the model tree. See “MCAD Formats” on
page 5 to identify the formats that use this functionality.

e Added support for file properties on model tree nodes. This is displayed as another tab in the
Entity properties dialog. See “MCAD Formats” on page 5 to identify the formats that use
this functionality.

e Added support for PMI captures, views, reference geometries and hyperlinks for some MCAD
formats. See “MCAD Formats” on page 5 to identify the formats that have support for
these entities.

Markup Functionality

*  Replaced the text entity with a text box entity with ability to draw a box and type text directly
in the box. Text automatically wraps around when text box width is reached. Text box height is
automatically set to the height of the contained text.

Added option to set box visibility off from the Markup Entity Properties dialog box.

*  Enhanced the leader entity. A text box is created when a leader is created and text can be typed
directly in the text box. Text automatically wraps around when text box width is reached. Text
box height is automatically set to the height of the contained text. Added ability to set box
visibility off (from Markup Entity Properties dialog box).

Added alignment options to the leader entity. Leader text can be aligned w.r.t. the leader
polyline. Alignment options are available in the Markup Entity Properties dialog box.

*  Added support for file attachment markup entity. Users can now add attachments to markup
files.

*  Added support for signoff entity for both 2D and 3D drawings.

*  Added support for the Intellistamp markup entity.

*  Added numbering for note entities. Note entities created are automatically numbered
sequentially. If you wish to disable automatic numbering, set INI option
NOTENAME_AUTOGEN to 0.

See “New INI File Settings” on page 10
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Added support for filtering markup entities. Entities can be filtered by author, page, entity
type, layer or modification date.

Moved markup list (markup tree) to the bottom of the workspace. Added ability to move the
markup tree by updating the GUI file.

Added new INI option to enable or disable markup creation for office formats.

Office formats render differently on different machines if the fonts on the machines vary. Due
to differences in fonts, documents may have line breaks and page breaks that vary from one
machine to another. This could result in a situation where markup entities appear misplaced
w.r.t underlying text in documents. If you are using a AutoVue Server farm, we recommend
that you make sure all machines have the same fonts installed.

To disable markups for office formats, set INI option EnableOfficeMarkups to 0.

See “New INI File Settings” on page 10

MCAD Formats

CATIA 5:
* Added support for CATIA 5 R18
* Added support for CATIA 5 R17 SP5/SP6
* Added support for PostScript fonts for CATIA 5 drawings
* Added notification for missing XREFs to the model tree
* Added support for file properties on the model tree nodes
* PMI Enhancements
*  Added support for Captures
*  Added support for Views
*  Added support for Reference Geometries
*  Added support for PMI external hyperlinks
* Added support for Raster Fill patterns for CATIA 5 drawings
* Added font substitution for missing native fonts
* Improved model tree display — more accurate name and hierarchy display
CATIA 4:
* Added notification for missing XREFs to the model tree
* Added font substitution for missing native fonts
Unigraphics
* Added support for Unigraphics NX5
* Added notification for missing XREFs to the model tree
* Added support for file properties on the model tree nodes
* Added font substitution for missing native fonts.
SolidDesigner
* Added support SolidDesigner 2007 (versions 15.00, 15.00A, 15.00B, 15.50, 15.50A)
* Added notification for missing XREFs to the model tree
* Added support for file properties on the model tree nodes
Parasolids
* Added support for versions 19.0 and 18.1
Autodesk Inventor
* Added notification for missing XREFs to the model tree
* Added support for file properties on the model tree nodes
» Improved parsing of Inventor files
SolidWorks
* Added support for SolidWorks version 2008
* Added notification for missing XREFs to the model tree
* Added support for file properties on the model tree nodes
* Removed support for INI option SWSYMBOLFILE. Location to the symbol file can now
be specified using the font path (XFONTPATHS ini option) .
SolidEdge
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* Added support for SolidEdge version 20
+ IGES
* Added notification for missing XREFs to the model tree
* Added support for file properties on the model tree nodes
*  Pro/ENGINEER
* Added notification for missing XREFs to the model tree
* Added support for file properties on the model tree nodes
* Added font substitution for missing native fonts
* Added support for PMI external hyperlinks

* Added support for Hyperlinks in 2D files (for files saved with no display lists)

+ STEP

* Added support for XREFs for STEP assemblies

» Improved handling of large models

* Added notification for missing XREFs to the model tree

* Added support for file properties on the model tree nodes
*  Maintenance and bug fixes for the following formats:

+ ACIS

+ CATIA 4

* CATIAS

* Autodesk Inventor

* SolidEdge

* SolidDesigner

* SolidWorks

* Pro/ENGINEER

+ IGES

+ STEP

 Unigraphics

AEC Formats

*  Added support for IFC format.
*  Added support for AutoCAD version 2009 files

*  Added support for the following new features for AutoCAD version 2008 files

* MicroStation 8 underlays in AutoCAD drawings
» Paragraph-based text formatting
*  Added support for Mechanical Desktop version 2008

*  Added support for ME10 (Onespace Designer Drafting) 2007 (versions 15.00A, 15.00B,

15.50, 15.50A)
*  Added drawing (entity) information support for AutoCAD 2008
*  Added support for TTF fonts for ME10 files
*  Added support for SmartSketch version 2007

*  Added font substitution for missing native fonts for the following formats:

* AutoCAD
* MicroStation 7 and 8
* MEI10/OneSpace Designer
*  Maintenance and bug fixes for the following formats:
¢ AutoCAD
e MicroStation
* HPGL
« MEI10
* Autodesk DWF
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EDA Formats

*  Added support for Zuken Cadstar version 9.0
*  Added support for PADS version 2007
* Added support for OrCAD Layout and Schematics version 16
*  Added support for Occurrence Attributes (OATs) for DxDesigner
*  Added INI option ECAD LOAD 3D PAGE to enable/disable loading of 3D pages for EDA
formats that contain 3D pages.
See “New INI File Settings” on page 10
e Improved performance for Allegro Layouts
*  Added font substitution for missing native fonts for the following formats:
* Altium Designer (Protel)
* OrCAD Layout
* Cadence Allegro
* Cadence Allegro IPF
* Mentor BoardStation
* Mentor PADS
» Zuken CADSTAR
+ P-CAD
* PDIF
*  Maintenance and bug fixes for the following formats:
e Cadence Allegro
* Cadence Concept HDL
* Zuken CADIF
* DxDesigner
» Expedition
* IDF
* Mentor BoardStation
* ODB++
* OrCAD
* Protel (Altium Designer)
* Specctra
» Zuken CadStar

Office Formats

e Added support for Word version 2007
e Added support for Excel version 2007
e Added support for Visio version 2007
e Added support for vertical text for Word
*  Added support for external font mapping for the following formats:
* Word
* RTF
See docfont.map that is at <AutoVue Installation Directory>\bin\fonts.
*  Added support for grouped shapes for the following formats:
* Excel
* PowerPoint
*  Added new option OutlookLinkFlag for Microsoft Outlook formats to disable hyperlinks or
attachments or both.
See “New INI File Settings” on page 10
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General

*  Added option Optimized Rendering in the 3D section in the Options > Configure dialog
to determine if AutoVue should use JOGL’s heavyweight or lightweight widget to render 3D
models. Option is on by default and uses heavyweight rendering (uses hardware acceleration)
on all clients except for clients on the MAC OS. This provides optimized performance when
rendering 3D models. If option is off, hardware acceleration is not used and model is rendered
using the lightweight widget. We recommend turning option off if you have problems
performing measurements on 3D models. Change to this option will need a restart of the
AutoVue client.

The applet parameter heavyweight takes precedence over this option. Heavyweight applet
parameter has to be set to AUTO (the default value) for this option to take effect.

*  Added option to control visibility of PMI entities for large models. You can specify a threshold
for PMI entities and AutoVue will not render any PMI entities if the model has more PMI
entities than the threshold. This helps optimize loading of models that contain a large number
of PMI entities. Option is in section PMI Initial Visibility in the 3D section of the Options >
Configure dialog.

e Added a check box, Resolve Local Resources, under the General section in the Options >
Configure dialog to enable/disable resource resolution on client side. By default, it is enabled
and the INI option ResolveResources is set to 1.

*  Added support for detecting Apache Web Server 2.2.8 during installation. Installer detects
Apache Web Server 2.2.8 if it is installed and installs AutoVue client files (htmls, jars, help
files) to a jVue folder under Apache Web Server’s docroot.

*  Consolidated all Service Pack releases for 19.2 into this 19.3 release.

Documentation

* A document for performance-related ini options, PerformanceRecommendations.pdf, is
included. This document provides some guidelines that could help improve file load and
manipulation performance. It is located in <AutoVue Installation Directory>\docs.

Known Issues

Some known product issues are listed in this section. More known issues with the product are listed
in prdlim.pdf that is located in <AutoVue Installation Directory>\docs.

Windows VISTA

* Internet Explorer 7 runs as a low-integrity process on Windows VISTA by default. As a result,
the browser and its extensions (AutoVue client) can only write to low-integrity locations.
Windows VISTA intercepts attempts to write to medium or high integrity folders and redirects
requests to the user’s virtual store. This causes problems when exporting markups or
converting files or exporting mass properties or BOM results locally. Files written to medium-
integrity locations are only visible from the sandbox from Internet Explorer and are not
accessible from outside. The workaround is to add AutoVue client to trusted sites in Internet
Explorer or to write to low-integrity locations or to use another browser such as Firefox.

¢ OpenGL rendering on Windows VISTA could provide slower performance for 3D and this
could be related to the default video card driver shipped with VISTA. If you are experiencing
slower 3D performance with the Web Version, we recommend installing the latest video driver
from the video card vendor.

Formats Desupported in AutoVue 19.3

Due to low customer demand, Oracle AutoVue has dropped support for some file formats. This
allows Oracle AutoVue to focus resources on formats that matter most in our key markets. Below is
the list of file formats that are de-supported in release 19.3:

¢ CAD & Vector-based Engineering Formats
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* Anvil
« CALCOMP
* Generic CADD
« STEP KOSDIC
* VDA-FS
*  Electronic Design (EDA) Formats
* Cadence Allegro Extract
* GenCam
* Mentor Neutral
« GDSII
* Raster-based Engineering Formats
« EDMICS
« GTX
» Hitachi
+ JEDMICS
*  Vector Graphics formats
* Corel Presentation Exchange
* Lotus PIC file image
* SVG
* WordPerfect Graphics
*  Hybrid Engineering Formats
« GTX
e Raster & Bitmap Formats
*« AMIGA
* CorelDraw! Bitmap Preview
e CUT Raster
» Databeam
* GEN IMG Bitmap
« MAC
» SUN Raster
* WordPerfect Graphics Bitmap
«  FAX Formats
* Brooktrout
» Everfax
* Frecom
* Fujitso
* Gamma
* Generic-Fax
* Hybrid J-T
 Intel
* Net-Fax
* Product R&D Fax Modem
* Raw Group III
* Relisys
* Ricoh
* SciFax
* SmartFax
* Trigem
* WinFax Pro
* Worldport
*  Word processor Formats
* Amipro Document
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* Amipro Style Sheet
* Microsoft Write
* Word for DOS
* WordPerfect
* WordStar
* Database Formats
* Access
» Database Express
* FOX/Dbase
*  Spreadsheet Formats
e Lotus 1-2-3
* Lotus symphony
* Quattro
* Quattro Pro for DOS
* Quattro Pro for Windows
* Symphony

Features Desupported in AutoVue 19.3

*  Removed support for the following INI options for Adobe PDF documents:

* OverridePDFPrintSecurity
+ SHOWPDFIMAGESINTRUECOLOR

*  Nesting of a text markup entity with another markup entity is not supported

New INI File Settings

[ECAD]

Parameter

Description

Default

ECAD_LOAD 3D PAGE

Enable or disable display of 3D models of EDA
files.

Set to 0 to disable display of 3D model. This will
result in improvements in file load performance.
Set to 1 to enable display of 3D model.

Option applies to the following PCB formats:

e Zuken CADSTAR

*  Cadence Specctra

*  Altium Designer (Protel)

¢ OrCAD Layout

. ODB++
. Mentor BoardStation
« IDF

*  Mentor Expedition
*  Zuken CADIF
e Cadence Allegro

Syntax:
[ECAD]
ECAD LOAD 3D PAGE=<1/0>

1
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[Options]

Parameter

Description

Default

3DPerformancePreference=<0|
1>

This option orients the optimization in the prod-
uct towards speed or memory.

If set to 1, the optimization is assigned to the
speed performance.

If set to 0, the optimization is assigned to memory
usage.

This option impacts only the loading process of
EDA-3D and CATIA 4, CATIA 5, Pro/ENGI-
NEER, Autodesk Inventor, SolidDesigner,
Mechanica Desktop, ACIS, IGES and STEP 3D
models.

1

EnableOfficeMarkups

DEFAULTFILEUNITS

EnumPrinters

Enable/disable creation of markups for office
documents.

Set to 1 to enable markups for office formats.
Set to 0 to disable markups for office formats.
Syntax:

[Options]

EnableOfficeMarkups=<0/1>

Specify the unit to use if native file does not
contain units information.

Syntax:

[Options]
DEFAULTFILEUNITS=<1/2/5/7/8/9/10/11/12/
14/15>

where

1 - inches

2 - millimeters

5 - centimeters

7 - meters

8 - kilometers

9 - feet

10 - yards

11 - miles

12 - mils

14 - microns

15 - microinches

Specify if you wish to use a printer installed on
the AutoVue Server machine as a reference
Device Context so that printing resolution is
closer to the printer installed on the AutoVue
client machine. Option is used for hi-res printing
only.

Syntax:

[Options]

EnumPrinters=<0/1/2>

Set to 0 to cancel enumeration of printers.

Set to 1 to enumerate printers that are installed
locally on the server, and printers to which
previous connections have been made (for
example, a shared printer that has already been
connected.

Set to 2 to enumerate only printers that are
installed locally on the server.

1

1
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Parameter

Description

Default

ResetRotateandFlip

ACAD_PENSETTINGSAFFE
CTLINEWIDTH

CustomDocFontSubstitution

OutlookLinkFlag

DownloadWebResources

STEPHideCG

This option allows the user to choose rotation and
flip settings when viewing files.

Syntax:

[Options]

ResetRotateAndFlip=<0/1>

1 - render file with no rotation and no flipping. If
native file itself is rotated or flipped, native file
settings take precedence and file is rendered with
saved rotation/flip.

0 - render file with the rotation and flip settings
defined in AutoVue GUI or in AutoVue INI file.

Option is for AutoCAD drawings.

When set to 0, pen settings do not affect non-zero
constant width polylines.

When set to 1, pen settings affect non-zero
constant width polylines.

Specify the path of the font mapping file
(docfont.map) to use for word documents.
Syntax:

[Options]
CustomDocFontSubstitution=<path>

The docfont.map contains font mapping
information that identifies what font to use if a
font is missing. If you wish to modify font
mappings, update docfont.map

Enable or disable hyperlinks or attachments in
Outlook MSG files.

0 — Hyperlink on, Attachment on

1 — Hyperlink on, Attachment off

2 — Hyperlink off, Attachment on

3 — Hyperlink off, Attachment off

Syntax:

[Options]

OutlookLinkFlag=<0/1/2/3>

Enable or Disable download of images and other
web images when viewing Outlook MSG files.
Syntax:

[Options]

DownloadWebResources=<0/1>

Set to 1 to hide all construction geometry in the
STEP file.

Syntax:

[Options]

STEPHideCG=<0/1>

1

docfont.map in
bin\fonts

1

0
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Parameter Description Default

STEPFacePositiveColor Option applies to STEP files. 0
When set to 1, AutoVue uses either the color for
“BOTH?” sides of the face if it is set or the color
of the “positive” face side if it is set.
When set to 0, AutoVue uses either the color for
“BOTH?” sides of the face if it is set or selects the
“positive” or “negative” face side color
depending on the face sense.

Syntax:
[Options]
STEPFacePositiveColor=<0/1>
IFCCOLORS Specify group element colors for IFC files. IFCCOLORS=
Syntax: WALLSTANDARD-
y ax. CASES(255,255,255)
[Options] CURTAIN-

IFCCOLORS=GROUP ELEMENT NAME(r,g, ~ WALLS(255,255,255)
- - DOORS(255,219,153)

b) OTHERS(0,255,255)
or SLABS(205,91,69)
IFCCOLORS=GROUP_ELEMENT NAME(col = WALLS(255,255,255)
oriname) WINDOWS(122,197,2
where GROUP_ELEMENT NAME is the name %%

of the group element. For example DOORS,

WINDOWS, WALLS

(r,g,b) is the RGB value for the color
color_name is the string representing the color

All color definitions should be on the same line
and should be separated by spaces.

For example:

IFCCOLORS = WALLS(WHITE)
DOORS(GREEN) WINDOWS(BROWN)

Special element name OTHERS is used for all
elements that are not in the color definition.

Special color NONE is used when you want to
use the 3D default element color for a group ele-

ment.

IFC pre-defined color extension is defined as

below:

Color Name (R,GB)
LIGHTCYAN (188,255,255)
BROWN (205,91,69)
LIGHTYELLOW (255,219,153)
CADETBLUE (122,197,205)
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Parameter Description Default

IFCCOLORS_MODE Define the mode for default element colors for 3
IFC models.
Syntax:
[Options]
IFCCOLORS_MODE=<0/1/2/3>
where
0 - Mechanism of default element color is turned
off, i.e., colors are set from the file or if color is
not specified in the file, the 3D default color
specified in AutoVue is used.
1 - File colors are ignored and only default colors
are used.
2 - Default colors are used only for elements
without file-defined colors.
3 - Default colors are used for elements without
file-defined colors and to replace color BLACK.

IFCREADProperties Enable or disable loading of attributes for IFC 1
files.
Set to 1 to display all supported entity properties
for an IFC file.
Set to 0 to display only the default entity proper-
ties which are Display Mode, Name and Visi-
bility.
Syntax:
[Options]
IFCREADPROPERTIES=<1/0>

IFCLoadlInvisibleSpaces Enable or disable loading of internal spaces 1
boundary geometry.
Set to 1 to enable loading of internal spaces
boundary geometry.
Set to 0 to disable loading of internal spaces
boundary geometry.
Syntax:
[Options]
IFCLoadlInvisibleSpaces=<1/0>

IFCWINDOW_TRANSPARE Specify the transparency level for windows in 55
NCY IFC files.

Value is an integer between 0 (no transparency)

and 100 (full transparency).

Syntax:

[Options]

IFCWINDOW_TRANSPARENCY=55
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Parameter

Description

Default

J2KRESOLUTION

ProELoadCosmeticWires

SWWIRECOLORVISIBLE

TextBitmapRendering=<0|1>

Set to HIGH to display with a high resolution.
This could cause a decrease in performance.
Other values: LOW, MEDIUM, and
DYNAMIC.

You can also set 2KRESOLUTION values to
+num or -num, where num is a number between
1 and 100.

Setting the value to +num gives the same result
as DYNAMIC but increases the resolution by a
factor of num where num is a value from 1 to 100
(up to the maximum possible resolution of the
image). Note that this will decrease performance.
Setting to -num gives the same result as
DYNAMIC but decreases the resolution by a fac-
tor of num where num is a value from 1 to 100
(down to the lowest possible resolution of the
image). Note that this will increase performance.
Syntax:

[Options]

J2KRESOLUTION=<DYNAMIC | HIGH |
MEDIUM | LOW | +num | -num>

Set to 0 to turn off display of cosmetic wires. This
will result in performance improvements. Set to 1
to enable display of cosmetic wires.

Syntax:

[Options]

ProELoadCosmeticWires=<0|1>

Specify color to use for drawing SolidWorks
wireframe models for SolidWorks drawings.
Value should be an integer value specifying the
RGB color.

Syntax:

[Options]

SWWIRECCOLORVISIBLE=0

If set to 1, render small text glyphs using bitmaps.
If set to 0, text is not rendered using bitmaps.
Note: This option may affect most text in PDF,
TrueType text in ME10, and PostScript text in
CATIAS.

DYNAMIC

0 (Black)

MAILINSEPARATEPROCES
S

Specify whether to send mail in a new process or
to send mail in the current jvm process.

Note: This option is available only when MAPI is
supported.

Set to 1 to send out mail in a new process or
system call.

Set to 0 to send out mail in the current jvm
process.

If the current mail client is Lotus Notes, mail will
be sent out in a new process regardless of whether
this option is enabled or disabled.

Syntax:

[Options]
MAILINSEPARATEPROCESS=<0|1>
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Parameter Description Default
MailerPath Specify the path to the mail client executable.

Once the path is entered, it is saved in the user’s

profile.

If no path is specified, a dialog box appears

prompting for the file path.

Note: This option is available only when MAPI is

not supported.

Syntax:

[Options]

MailerPath=file path

MailerType Specify the type of mailer application once the auto
full path of the mail client is obtained.

*  When the parameter is set to mozilla, thun-
derbird, or auto, and the mail file path con-
tains mozilla or thunderbird, the mail client
will default to thunderbird.

»  Ifthe mail client is neither mozilla, thunder-
bird, or evolution, a standard mail message is
contructed.

Note: This option is available only when MAPI is

not supported.

Syntax:

[Options]

MailerType=<auto | mozilla | thunderbird |

evolution>

Note: Evolution is only for clients on a Unix

system.

[Markup Options]
Parameter Description Default
NOTENAME AUTOGEN Set to 0 to disable auto-numbering of note entities 1

ATTACHMENT MAX SIZE

Set to 1 to enable auto-numbering.
Syntax:

[Markup Options]
NOTENAME AUTOGEN=<0/1>

Specify the maximum size for attachment markup
entities. When creating attachment markup enti-
ties, if attachment size exceeds, an error message
appears to indicate that attachment size exceeds
the limit.

Syntax:

[Markup Options]
ATTACHMENT MAX SIZE=<value>

value is in MegaBytes.

0 (no limit)
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[Export Options]

Parameter Description Default
EXPORTTESSELLATIONTO  Control the mesh density when converting to 3D 0
L STL. Meshes are more dense if tolerance value is
smaller.
Syntax:
[Export Options]
EXPORTTESSELLATIONTOL=val
where
val can be 0.01, 0.005, 0.001, 0.0001
[AutoVueMobile]
Parameter Description Default
MrkPolicyFile Specify the path to the Markup Policy XML file <AutoVue Web
for the Mobile Pack. Version
Syntax: Installation>\bin\
[AutoVueMobile] markuppolicy.xml
MrkPolicyFile=C:\WV\bin\markuppolicy.xml
FileStreamEncryption Specify Encryption algorithm for both Markup RC4

and Mobile Pack password protection.
Syntax:

[AutoVueMobile]
FileStreamEncryption=<RC4/3DES>
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AutoVue 19.2: July 18, 2007

Packaging and Licensing

* Introduced new product packages (AutoVue EDA Professional, AutoVue Electro-Mechanical
Professional, and AutoVue 3D Professional - SME) and renamed some of the existing
packages.

System Requirements
The following are certified by Cimmetry Systems Corp.

Server

* Microsoft Windows 2003R2, Windows XP Sp2, Windows 2000 Sp4 or Vista-32bit
» The installation requires about 400MB of free space.
* The memory requirements depend on the size and the complexity of the files being viewed.

Client

Clients running the following Java Virtual Machines:

* SunJava VM 1.5.0 update 11, Sun Java VM 1.4.2 update 13, and Sun Java VM 6.0.
The following OSes and browsers:

* Windows XP with Microsoft Internet Explorer 6.0Sp2, Microsoft Internet Explorer 7,

FireFox 2.0

* Macintosh Power PC OS 10.4 with Safari 2.0.4.

 Solaris 10 Sparc with Mozilla 1.7

* Solaris 10 x86 with Mozilla 1.7

* Linux Redhat 4.4 with Firefox 2.0

* Linux SUSEI10 with Firefox 2.0

The following OSes and browsers are not certified by Cimmetry:
* Clients running Microsoft VM, and Sun Java VM 1.4 and below.

Integrations Certified with AutoVue 19.2

The following pre-19.2 Cimmetry VueLinks have been certified with AutoVue Web Edition 19.2:
¢ VueLink for Matrix version 19.1
* VueLink for Documentum version 19.1
e VueLink for SAP PLM version 19.1
* VueLink for OpenText version 19.1
¢ VueLink for SharePoint 19.1c1
* AutoVue Integration SDK 19.1

In addition to the list above, the integration with Agile PLM 9.2.2 has been certified with AutoVue
Web Edition 19.2.

MCAD Formats

+ CATIAS:
* Added support for CATIA 5 R17 and R17 Sp3/Sp4.
* Performed the following maintenance and bug fixes for CATIA 5 files:
* Improved projection of curves onto surfaces for CATIA 5 3D.
*  Improved support for text size and balloon text size for CATIA 5 Drawings.
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*  Improved support for axis lines for CATIA 5 Drawings.
*  Improved rounding of dimension values and tolerances for CATIA 5 Drawings.
*  Fixed position problem of some title block entities for CATIA 5 Drawings.
*  Fixed display of radius projected dimensions for CATIA 5 Drawings.
* Added support for 3D Points for 3D files.
* PMI enhancements:
*  Added support for NOA (Note Object Attributes) for 3D files.
*  Added support for TTF and Postscript fonts to render PMI entities in 3D files.
*  Added support for Z-Order.
«  Improved Text Alignment in Text Notes.
* Added support for wires in BRep for 3D part files.
* Improved color in BRep Mode for 3D files.
» Improved display name of construction geometries in the model tree for 3D files.
* Added support for Geometrical sets for 3D files.
* Added Mass Properties enhancements.
* Added support for Embedded JPEG and CCITT G3 raster images in 2D files.
* Improved support for hatching in drawings files.
* Added support for balloons in drawings files.
*  Unigraphics:
* Added support for Unigraphics NX3 and NX4.
*  SolidDesigner:
* Added support for SolidDesigner version 2006 (version 14.00).
* Added support for wires, WorkPlanes and Helical surfaces for 3D files.
*  Pro/ENGINEER:
* Added support for Pro/ENGINEER Wildfire 3.0.
* Added Pro/ENGINEER Integration with Wildfire 3.0.
» Enhanced PMI support for 3D files.
* Added support for Exploded Views in 2D files.
* Improved display of datum entities in 2D files (plane, axis, coordinate systems, etc.).
* Added support for Dual geometry tolerances in 2D files.
* Added support for Note parametric drawing labels in 2D files.
* Added support for the Picture file format (.pic) for 2D files.
* Added Error Messages when RenderEngine fails.
* Added support for bookmarking and display of nested family instances through
Pro/ENGINEER Integration.
* Added INT option ProEShowHiddenLineDashed to control the display and printing of
hidden lines in Pro/ENGINEER drawings. See “New INI File Settings” on page 6.
* Added the ProE2DViewDefaultStyle INI option to specify a default style to display 3D
projected views. See “New INI File Settings” on page 6.
* Added the ProE2DTanEdgeDefaultStyle INI option to specify the default line style for
tangent edges. See “New INI File Settings” on page 6.
*  SolidWorks:
* Added support for SolidWorks version 2007.
» Improved display of SolidWorks drawings containing 3D overlays.
* Added support for TrueType fonts to render PMI entities in 3D files.
* Added support for layers in SolidWorks 2007 2D files.
+ CATIA 4:
* Added support for Italic style for Dimension2 Text.
* Added support for units in dimensions.
» Performed general bug fixes for CATIA V4.
* Added new INI option CATIAPROJECTFILEPATH to specify the path to the project file.
See “New INI File Settings” on page 6.
*  Parasolid:
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* Added support for version 17.1 and version 18.0.
*  Autodesk Inventor:
* Added support for Autodesk Inventor 2008 and Autodesk Inventor 11.
* Added support for native file properties.
* Improved support for feature assemblies.
» Improved support for embedded objects through the bookmark tree.
* Added support for 2D layers.
*  SolidEdge:
* Added support for SolidEdge version 19.
* Added support for file properties.
*+ IGES:
* Added support for XREFs.

EDA Formats:

*  Added support for Cadence Allegro versions 15.5, 15.5.1, and 15.7.

*  Added support for Mentor Expedition version 2005.

*  Added support for Mentor Board Station version 8.10.

*  Added support for CadStar version 8.0.

*  Added support for ODB-++ version 6.5.

*  Added support for Altium Designer versions 6.0, 6.3, 6.4, and 6.5.

*  Added support for PADS2005 SPac2 and SPac3.

*  Added support for DxDesigner 2005.

*  Added support for Protel DXP/2004 binary and ASCII Schematics.

*  Added support for Protel DXP Project files.

*  Added 3D support for ODB++.

*  Added support for Layout and Capture for Orcad 15.7.

*  Added 3D support for Zuken CADIF.

*  Added 3D support for Cadence SPECCTRA files.

*  Added support for Junctions, Native layer sets, and Tie legs in Expedition files.
*  Added support for Go to Net Instances for Mentor Expedition Design Capture files.
*  Performed maintenance and bug fixes for all EDA formats we support.

AEC Formats:

*  Added support for AutoCAD 2007 Service Pack 1 and AutoCAD 2008.

*  Added support for Autodesk Mechanical/Mechanical Desktop version 2007.

*  Added support for ME10 2006 (OneSpace Designer Drafting version 14.00).

*  Added support for MicroStation version 8 XM.

*  Added support for RGB colors in MicroStation version 8 XM files.

*  Improved support for 3D MicroStation 7 files.

*  Added support for SmartSketch versions 4.0 and 5.0.

*  Added support for DWF versions 6.01, 6.11, 6.20.

*  Added support for JPEG-CYMK format.

*  Added support for Drawing Info for AutoCAD version 2007 files (EDAT).

*  Improved support for Viewport Front and Back clipping for DWG files.

* Improved Splines display for CadKey files.

* Improved Linestyle support for CGM files.

*  Added support for Visibility of Raster Xrefs in DGN8 XM files.

*  Performed maintenance and bug fixes for the following formats: CadKey, CGM, DGN 7/8,
Autodesk DWF, AutoCAD DWG, HPGL, ME10.

Office-Desktop Formats

*  Added support for Microsoft Outlook format.
*  Added support for Adobe Acrobat 8.0 including packages files.
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Added support for 1904 Date System in Excel files.

Disabled streaming file generation for PDF files. PDF streaming file generation is controlled

through jvueserver.metacache.pdf.enable property in jvueserver.properties file. It is

disabled by default.

Microsoft Word:

* Added support for “Keep with Next” flow control.

* Added support for “Orphan Control” flow control.

* Added support for Hyperlinks.

* Added support for Bookmarks.

* Added support for Nested Tables.

* Added support for Gradient fill.

* Added support for Legacy tabs.

* Added the DOC_SHOWTABLEGRIDLINES INI option to show or hide table gridlines.
See “New INI File Settings” on page 6.

+ Disabled streaming file generation for files that contain current date and time fields.

Performed maintenance and bug fixed for the following formats: Microsoft Word, Microsoft
Excel, Microsoft PowerPoint, RTF, PDF, TXT, and Visio

Raster Formats

Performed maintenance and bug fixes for TIFF, JPEG, and JPEG 2000 formats.

MCAD Functionality

Improved accuracy of mass properties computation. Also added error reporting when Mass
Properties computation fails.

Replaced 3D Global Axes with new Volumetric Axes with better orientation perception and
readability.

EDA Functionality

Enhanced and improved the usability of cross-probe functionality:

* Added support for both built-in (auto) and user defined logic that determines the target
design type to cross probe against for files containing multiple designs and/or multiple
design types (PCB vs. schematic).

* Added support for Net and RefDes instance Navigation: If the target Net or component is
present on multiple schematic sheets, the user is able to select navigate through all the
instances.

Enhanced and improved usability of layer ordering and layer visibility:

* Added support for physical layers in the Layers dialog.

* Added support for setting visibility of physical layers.

» Enhanced entity filtering feature: Added ability to control the visibility of entity types
independently for each physical layer.

* Added support for a “Bring to front” feature that puts a physical layer at the front (on top) of
all other layers with a single click.

* Added support for logical layer ordering through drag and drop of single or multiple layers.

* Improved overall usability of the Layers dialog.

Improved rendering performance when layer visibility is modified.

Added support for layer sets that are saved in Allegro and Expedition designs.

Added support for tooltips to display entity properties by hovering the mouse over the entity.

Added support for entity search/browse across multiple sheets of a schematic.

Improved entity selection hightlighting:

* Added a button to the toolbar for more accessible control over the entity highlight type.

* Added control over dim level when Dim Unselected is selected.

Improved performance for EDA functionality: Minimum distance and Design Verification.
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* Improved client side memory usage for large EDA files (memory management).

*  Added support for Multipage Nets for many Schematics formats (PADS, Mentor Board
Station, Zuken CadStar, Orcad Capture, Mentor Expedition, IFF, Cadence Concept Design
Entry HDL, and DxDesigner).

*  Added support for partial and partial with toggle layer sets in Cadence Allegro files.

Markup Functionality

Improved usability of markup functionality:
*  Added support for sorting in the markup entity tree.

*  Added support for turning markups on/off and setting the active markup from the markup tree.

*  Added support for setting all entity graphical attributes from within a single dialog.

e Ability to add arrows to all line entities.

*  Added display of page number on the status bar in markup mode.

*  Improved workflow for entering markup mode. The Markup Open dialog only appears when
needed.

*  Added an option to turn off markups after they have consolidated. Shows the consolidated
markup instead.

*  Added the ability to press the ESC key to abort the creation of markup entities.

e Improved Markup functionality:
* Added support for creating AutoVue markup Symbol Libraries from the AutoVue Client.
* Added support for attaching Text, Note or Hyperlink to a markup entity.
* Added support for exporting markups to DXF.

General Functionality

*  Added support for adding a Watermark on top of the file being viewed.
* Implemented a new Configuration dialog with major usability enhancements.
*  Added printing support to Compare mode.

«  Better handling of multi-page documents in Compare mode, for 2D files with the same number

of pages (Specifically, the ability to synchronize pages numbers between the two documents
being compared).

*  Enhanced usability of File Open dialog e.g. Added support for browsing server side
directories.

*  Added support for collaboration on local files.

*  Added support for resolving external references and other resource (XREFs) for uploaded
files. For example, resolving the parts for an assembly that is uploaded from the client
machine.

* Added a new INI option, FOLDERPERMISSIONS, to switch off the verification of client
permissions for accessing the UNC path. See section “New INI File Settings”on page 6.

*  Added new INI options, DisableWatermark and DisableHeaders, to disable modification of
headers, footers and watermark in the print properties dialog. See section “New INI File
Settings”on page 6.

General

*  Added new product variations: AutoVue EDA Professional, AutoVue Electro-Mechanical
Professional, and AutoVue 3D Professional - SME.
» Refer to formats.pdf for the formats supported by these product variations.
 Refer to featurelist.pdf for the features included in these product variations.

*  Improved the messages that appear when a license is exceeded.

*  Consolidated all Service Pack and Format Pack releases for 19.1 into this 19.2 release.

Unavailable Support in AutoVue 19.2

Support for the following formats is no longer available in AutoVue 19.2:
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e DirectModel (JT) versions 8, 7, 6.4

e VRML versions 2, 1.1, 1.0, 97

*  Postscript (EPS)

e Adobe Illustrator version 8 and below

*  Archived Formats: 7Zip, BZip, CAB, Debian, GZip, RAR, RPM,TAR

Customers who work with these formats regularly are encouraged to remain with their AutoVue
19.1 version and not update to 19.2. Customers will be notified when support for these formats is
re-introduced.

Native font resources for the formats listed below will not be shipped in AutoVue version 19.2.

These fonts can be either obtained from the native application or can be downloaded from the

Internet.

*  2D: AutoCAD, MicroStation 7 and 8 (linestyle resources will not be shipped), Me10/
OneSpace Designer Drafting

*  EDA: Cadence Allegro, Cadence Allegro Extract, Cadence Allegro IPF, Mentor BoardStation,
Mentor PADS, OrCAD layout, PCAD, PDIF, Protel, Zuken CadStar

*  3D: Pro/ENGINEER, Unigraphics, CATIA 5, CATIA 4, SolidWorks (symbol file will not be
shipped), SolidDesigner Bundle files

To add these fonts to AutoVue, use the XFONTPATHS Ini option. Please refer to the section

Appendix F: List of Ini File Options in the Web Edition Installtion and Administration

Manual.

AutoVue 19.2 Web Edition does not provide a license usage chart in the AutoVue Server console.
However, the license usage can still be obtained from the licusage.out file in the bin directory of
the AutoVue Server installation.

New INI File Settings

[Options]

Parameter Description Default

3DMASSPROP_MESH BEHA Specify how to handle mesh bodies when computing 1
VIOR mass properties.This option can have one of the
following values:
0 - Exclude from mass property computation.
1 - Include in mass property computation.
2 - Handle selection: Include in mass property
computation only if the selection is fully made with
mesh bodies.
Syntax:
[Options]
3DMASSPROP_MESH BEHAVIOR = [0]1/2]

3DMASSPROP_SHEET BEHA  Specify how to handle sheet bodies when computing 2
VIOR mass properties. This option can have one of the
following values:
0 - Exclude from mass property computation.
1 - Include in mass property computation.
2 - Handle selection: Include in mass property
computation only if the selection is fully made with
sheet bodies.
Syntax:
[Options]
3DMASSPROP_SHEET BEHAVIOR =[0]1]2]
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Parameter Description Default

CATIASBUILDCGMSETS Controls the display of Geometrical sets. 1
Set to 1 to show geometrical sets structure in the Model
Tree.
Syntax:
[Options]
CATIASBUILDCGMSETS = <0|1>

CATIAPROJECTFILEPATH Specify the directory path for the location of project empty
files. If the option is set, it will override the exisiting INI
option CATIAProjectFile. Otherwise if the option is not
set or project file(s) cannot be found in the specified
directory, the old option (CATIAProjectFile) will be
used.
Syntax:
[Options]
CATTAPROJECTFILEPATH = <file path>

CLIPLIMIT Reduce file loading time. 1500
Set n to more than 1500: the clipping is performed on
the server (in "TILED" rendering format).
Set n to less than 1500: the clipping is performed on
the client (in “METAFILE(CMF)” rendering format)
Syntax:
[Options]
CLIPLIMIT =n

DGNSLWDISPLAYSCALE Specify a floating point value, larger or equal to 0.0, 1.0
representing the scaling factor which would be applied
to all line weights in the drawing.
Set to 0.0: Reduces all line weights to 0 (1 pixel width).
Set to 1.0: Line weights remain at their default value.
Set to 0.5: Reduces all line weights by half
Set to 2.0: Multiplies all line weights by 2.

Syntax:

[Options]

DGNSLWDISPLAYSCALE = [0.0-1000.0]
DOC _SHOWTABLEGRIDLINE  Turn table gridlines on and off. 0
S Set to 1 to display the table gridlines.

Set to 0 to hide the table gridlines.

Note: Unlike cell borders, gridlines never print.
Syntax:

[Options]

DOC_SHOWTABLEGRIDLINES = <0|1>

FOLDERPERMISSIONS Switch off the verification of client permissions for 1
accessing the UNC path.
Set to 1 to follow the standard folder permissions.
Set to 0 to allow the client to access file locations for
which the client does not have permissions.
Syntax:
[Options]
FOLDERPERMISSIONS = <0|1>
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Parameter Description Default

ForcePMIsZOrder Invalidate the 0
PMI_ATTRIB_ RENDERABOVEMODEL generic
attribute effect : 3D PMIs are not forced above the model
and may be occluded by it, depending on its orientation.

Syntax:

[Options]

ForcePMIsZOrder = <0|1>
FULLCOLORPRINTERSUPPO  Enable color printing for some monochrome images. 0
RT Set to 0: Default AutoVue behavior, where some

transparent monochrome images are not printed in color

due to some printers that do not fully support

transparency.

Set to 1: Enables certain monochrome images to be

printed in color with color printers. This flag should not

be set by default because it has some drawbacks and may
cause some problems on some printers.

Enabling option 1 could cause a decrease in

performance:

*  The spool size is much larger because there is 8 to
24 times more information sent to the printer.

*  Not all printers support image transparency and
using them with this option may yield incorrect
results.

Syntax:

[Options]

FULLCOLORPRINTERSUPPORT = <0|1>

IGESLOADDRAFTFIRST Set to 1 to display the 2D page first, display of the 3D 0
page as a 2D projection of the 3D model, in IGES files.
Syntax:
[Options]
IGESLOADDRAFTFIRST = <0|1>

J2KRESOLUTION Added two new possible values for this option. DYNAM
Setting to +num gives the same result as DYNAMIC but  IC
increases the resolution by a factor of num where num is
a value from 1 to 100 (up to the maximum possible
resolution of the image).

Setting to -num gives the same result as DYNAMIC but
decreases the resolution by a factor of num where num is
a value from 1 to 100 (down to the lowest possible
resolution of the image).

Syntax:

[Options]

J2KRESOLUTION = [DYNAMIC | HIGH | MEDIUM |
LOW | +num | -num ]

LWDEFAULT Set the default line weight. 25
Specify a value between 1 (which corresponds to
0.01mm) and 100 (which corresponds to Imm).
Default value is 25 (which corresponds to 0.25mm).
Syntax:
[Options]
LWDEFAULT = [1-100]
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Parameter Description Default

MAXPRINTERDPI Maximum printer DPI for native printing. Lower DPI 600
setting speeds up printing. Default value is 600 DPI.
Syntax:
[Options]
MAXPRINTERDPI = <DPI value>

MESHBUILDTOPOLOGY Set to 0 if you do not want to build the topology in mesh 1
mode. Applies to the following file formats:
« CATIAS
*  Pro/ENGINEER
*  SolidWorks
*  Unigraphics
. STL
Note: This option replaces the following INI options:
SWBUILDMESHTOPOLOGY,
CatiaSMeshBuildTopology and
BUILDMESHTOPOLOGY.
Syntax:
[Options]
MESHBUILDTOPOLOGY = <0|1>

NOSYMBOLTTF Set to 1 to override the Charset of Symbol fonts. It will 0
be replaced by the default Charset. This option applies to
DWEF and DWG files only.
Syntax:
[Options]
NOSYMBOLTTF = <0|1>

PRINTBANDSIZE The size of one printing band for requesting from the 5.0
server in megabytes.
Syntax:
[Options]
PRINTBANDSIZE = <Band size value>

ProE2DTanEdgeDefaultStyle Specify the default line style for tangent edges if itisnot 0
saved in the native file. The styles are:
0 - Solid
1 - Disabled
2 - Control
3 - Phantom
4 - Dimmed
Syntax:
[Options]
ProE2DTanEdgeDefaultStyle = [0-4]

ProE2DViewDefaultStyle Specify a default style to display 3D projected views: NO
. HIDDEN HIDDEN
. WIREFRAME
. SHADING
. NO HIDDEN
Syntax:
[Options]
ProE2DViewDefaultStyle = [HIDDEN | WIREFRAME
| SHADING | NO HIDDEN]

Release Notes - AutoVue Web Version -26 - June 20, 2008



Parameter

Description

Default

ProEShowHiddenLineDashed

RequestTimeout

ResolveResources

TIFF_ZERO PIXEL

USERXFONTPATHS

USERXREFPATHS

This option controls the display and printing of hidden
lines contained in Pro/ENGINEER drawings.

Set to 1 to display and print hidden lines as dashed lines.

Set to 0 to display and print hidden lines as solid lines.
Syntax:

[Options]

ProEShowHiddenLineDashed = <0|1>

Partial results polling timeout in milliseconds.
Syntax:

[Options]

RequestTimeout = <timeout value in milliseconds>

Enable/disable resource file lookup by the client.

When set to 1, the client will try to locate resource files,
when set to 0, the client will never receive a request to
resolve resources.

Syntax:

[Options]

ResolveResources = <0|1>

Specify how pixel values are interpreted in black and
white TIFF files.

Set to BLACK to force zero pixels to display black.
Set to WHITE to force zero pixels to display white.
Set to FILE to force zero pixels to display as the pixel
color specified in the file.

Note: This only applies to black and white TIFF
images.

Syntax:

[Options]

TIFF_ZERO PIXEL = [BLACK | WHITE | FILE]

Specify the paths for external font lookup on the client
side. The path will appear in the Configuration dialog in
General > Font Paths.

Syntax:

[Options]

USERXFONTPATHS = <semicolon separated list of
paths>

Specify the paths for XRef lookup on the client side. The
path will appear in the Configuration dialog in General >
XRef Paths.

Syntax:

[Options]

USERXREFPATHS = <semicolon separated list of
paths>

0

500

FILE

none

none
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[ECAD]

Options should be specified in the [ECAD] section in the INI file.

Parameter

ALLEGRO_USETRUETYPEFO
NTS

CrossProbe_Action

CROSSPROBE_AUTOMATIC
PAGETYPE

ECAD 3D SHOWHOLES

ECAD DIMLEVEL

ECAD_LAYER EXPANDCOL
LAPSE_LOGICAL

Description

Set to 0 to use stroke font.

Set to any other integer value to use TrueType font
instead.

Syntax:

[ECAD]

ALLEGRO USETRUETYPEFONTS = <0|1>

Specify entity selection behavior when crossprobing
EDA files. This option can have one of the following
values:

0 - Keep zoom level

1 - Zoom selected

2 - Zoom Fit

Syntax:

[ECAD]

CrossProbe Action = <0|1[2>

Specifies whether the Automatic option is enabled or
disabled when cross probing EDA files.

Set to 1 to enable Automatic mode during an EDA cross
probe.

Set to 0 to disable Automatic mode during an EDA cross
probe.

Syntax:

[ECAD]

CROSSPROBE_AUTOMATIC_PAGETYPE = <0|1>

Set to 1 if you want holes to be drawn in the 3D model.
Set to 0 if you do not want holes to be drawn in the 3D
model (increases performance).

Note: Currently only affects Allegro files.

Syntax:

[ECAD]

ECAD 3D SHOWHOLES = <0|1>

Specify the dim level. The value corresponds to a
percentage. For example 0.3 is 30%.

Change takes effect whether you change it manually or
through the GUI. Set a value between 0.0 and 1.0.
Syntax:

[ECAD]

ECAD DIMLEVEL = [0.0-1.0]

Expand or collapse the Logical Layers pane in the
Layers dialog.

Set to 0 to expand the Logical Layers pane.

Set to 1 to collapse the Logical Layers pane.

Syntax:

[ECAD]

ECAD_LAYER EXPANDCOLLAPSE LOGICAL =
<0[1>

Default

0

0.5
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ECAD_LAYER EXPANDCOL Expand or collapse the Physical Layers pane in the 0
LAPSE PHYSICAL Layers dialog.

Set to 0 to expand the Physical Layers pane.

Set to 1 to collapse the Physical Layers pane.

Syntax:

[ECAD]

ECAD_LAYER _EXPANDCOLLAPSE PHYSICAL =

<0[1>

ECAD_SEARCH _DESIGN EDA entity searching scope. 0
Set to 1: the search scope is the entire design.
Set to 0: the search scope is current page.
Syntax:
[ECAD]
ECAD SEARCH DESIGN = 0|1

ECAD_SELECTIONHIGHLIG Select either Highlight Selected or Dim Unselected as 0
HT the default behavior when selecting entities.

Set to 1 when Dim Unselected is selected.

Set to 0 when Highlight Selected is selected.

Option takes effect whether you change it manually or

through the GUI.

Syntax:

[ECAD]

ECAD_SELECTIONHIGHLIGHT = <0|1>

[MARKUP OPTIONS]
Option should be specified in the [MARKUP OPTIONS] section in the INI file.

CONSOLIDATE_OPENASACT  Set to 1 to turn on the Open as Active Markup optionin 1
IVE the Markup Consolidation dialog.
Set to 0 to turn off this option.
Syntax:
[MARKUP OPTIONS]
CONSOLIDATE_OPENASACTIVE = <0|1>

[PRINTOPTIONS]
Options should be specified in the [PRINTOPTIONS] section in the INI file.

Parameter Description Default

DisableHeaders When set to 1, user will not be able to edit entries for 0
headers or footers in the print properties dialog (for both
print and print preview). Option goes under section
[PRINTOPTIONS] in the INT File.

Syntax:
[PRINTOPTIONS]
DisableHeaders = 1

DisableWatermark When set to 1, user will not be able to edit entries for 0
watermark in the print properties dialog (for both print
and print preview). Option goes under section
[PRINTOPTIONS] in the INI File.
Syntax:
[PRINTOPTIONS]
DisableWatermark = 1

[Ul Colors]
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Options should be specified in the [PRINTOPTIONS] section in the INI file.

Parameter Description Default
BKCOLOREDA Specify background color for EDA files. 0
Note: For each color option, specify an integer that
represents an RGB color (Red + 256 * Green +
65536*Blue). The values for Red, Green, and Blue range
from 0 to 255.
Syntax:
[Ul Colors]
BKCOLOREDA
The following options should be specified in the jvueserver.properties file.
Parameter Description Default
dms.save.metafile Specify whether or not streaming files are saved in the true
DMS.
Set to true: Streaming files are saved in DMS.
Set to false: Streaming files will not be saved in DMS.
jvueserver.metacache.pdf.enable Set to false: Streaming files is not generated for PDF false
and Word PDF files.
Set to true: Streaming files is generated for PDF and
Word PDF files.
The following options should be specified in the FrmApplet.html file.
Parameter Description Default
SessionXFontPaths Set <PARAM NAME="“SessionXFontPaths”
VALUE="font path">
Font will display (be resolved the base file (drawing/
assembly)
SessionXrefPaths Set <PARAM NAME="SessionXrefPaths”

VALUE="“xref folder path”>
XRefs will display (be resolved) in the base file
(drawing/assembly).
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Copyright © 1999, 2008, Oracle and/or its affiliates. All rights reserved.

Portions of this software Copyright 1996-2007 Glyph & Cog, LLC.

Portions of this software Copyright Unisearch Ltd, Australia.

Portions of this software are owned by Siemens PLM © 1986-2008. All rights reserved.

This software uses ACIS® software by Spatial Technology Inc. ACIS® Copyright © 1994-1999 Spatial Tech-
nology Inc. All rights reserved.

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be trademarks of
their respective owners.

This software and related documentation are provided under a license agreement containing restrictions on use
and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license
agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit,
distribute, exhibit, perform, publish or display any part, in any form, or by any means. Reverse engineering,
disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If
you find any errors, please report them to us in writing.

If this software or related documentation is delivered to the U.S. Government or anyone licensing it on behalf
of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS

Programs, software, databases, and related documentation and technical data delivered to U.S. Government
customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Fed-
eral Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication, dis-
closure, modification, and adaptation shall be subject to the restrictions and license terms set forth in the
applicable Government contract, and, to the extent applicable by the terms of the Government contract, the
additional rights set forth in FAR 52.227-19, Commercial Computer Software License (December 2007). Ora-
cle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

This software is developed for general use in a variety of information management applications. It is not
developed or intended for use in any inherently dangerous applications, including applications which may cre-
ate a risk of personal injury. If you use this software in dangerous applications, then you shall be responsible to
take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of this software.
Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software in
dangerous applications.

This software and documentation may provide access to or information on content, products and services from
third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties
of any kind with respect to third party content, products and services. Oracle Corporation and its affiliates will
not be responsible for any loss, costs, or damages incurred due to your access to or use of third party content,
products or services.
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